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АНОТАЦІЯ 

 

Відповідно до мети дослідження робота присвячена розробці програмного 

забезпечення музею КНТЕУ у віртуальній реальності. Ця програма є 

покращеним варіантом музею КНТЕУ у 3д та є сумісною з сучасними 

контролерами віртуальної реальності. Обрана мова програмування – C++ та 

BluePrints Visual Scripting. Готове програмне забезпечення було успішно 

протестовано відповідно до функціональних вимог. 

 

Ключові слова: Віртуальна реальність, програмне забезпечення, КНТЕУ, 

музей, 3д. 

 

 

ABSTRACT 

 

In accordance with the purpose of the study, the work is devoted to the 

development of software of the KNUTE museum in virtual reality. This program 

is an improved version of the KNUTE Museum in 3D and is compatible with 

modern virtual reality controllers. Selected programming language - C ++ and 

BluePrints Visual Scripting. The finished software has been successfully tested in 

accordance with the functional requirements. 

 

Keywords: Virtual reality, software, KNUTE, museum, 3d.
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ВСТУП 

VR - це наше майбутнє. Як тільки будуть виправлені всі недоліки, і 

буде вирішено питання з адаптацією людини до нового середовища, ця 

технологія отримає масове застосування в усіх сферах нашого життя, 

спростить її і зробить краще. Лікарі зможуть підготуватися до складних 

операцій, авіація отримає нові симулятори, які дозволять набагато 

ефективніше готувати персонал, а прості люди зможуть максимально 

комфортно проводити своє дозвілля, наприклад, за переглядом фільму 

або занурившись в цікаву гру. 

Але умови для масового впровадження практики створення 

віртуальних музеїв в наш час, зокрема у закладах вищої освіти повною 

мірою не створені. Тому подальше дослідження спрямоване на пошук 

можливостей створення умов для його реалізації, в першу чергу, на 

прикладі створення віртуального музейного простору університету. 

● Точність, яку містять тривимірні моделі, не має аналогів і жоден 

інший звичайний підхід до моделювання або візуалізації не може бути 

настільки точним, як 3D-моделювання. 

Мета роботи – дослідження існуючих підходів і концепцій та 

створення 3D образів музейних експонатів для віртуального музею 

КНТЕУ.  

Об’єкт дослідження – віртуалізація музейного простору історії 

КНТЕУ.  

Предмет дослідження: технічні та програмні засоби відтворення 

3D-образів музейних експонатів КНТЕУ 

Завдання дослідження: аналіз вітчизняних і зарубіжних публікацій 

та інформаційних джерел  по темі науково-дослідної роботи. 
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РОЗДІЛ 1. ДОСЛІДЖЕННЯ ІСНУЮЧИХ ПІДХОДІВ І 

КОНЦЕПЦІЙ  

1.1 ВІРТУАЛЬНА РЕАЛЬНІСТЬ В СУЧАСНІЙ ІТ- IНДУCТPIЇ 

VR - це вигаданий плід розумової діяльності людини. Це те, що існує 

не в нашій голові, а в комп'ютерному коді. Віртуальна реальність і 

доповнена реальність вражають своїми масштабами: відео з оглядом в 

360 градусів, цілі ігрові світи зі своїми законами, особливостями і 

персонажами. 

Іноді складно зрозуміти, де реальний об'єкт, а де творіння 

комп'ютера - настільки високого рівня досягли технології. 

Багато вузів переводять частину предметів на дистанційне навчання. 

Їм простіше і вигідніше запросити іменитого професора і транслювати 

його лекції по скайпу, ніж возити його по всіх містах, де є філії цього 

вузу. 

Недовго залишиться чекати, поки ця модель навчання прийде в наші 

школи. Вона дуже вигідна для учнів, адже куди простіше надіти окуляри 

віртуальної реальності, ніж сидіти в задушливому класі, лежати вдома 

на дивані, але при цьому перебувати в оточенні однокласників і 

вчителів. 

VR активно використовується в медицині: хірургії, психології та 

реабілітації. Як отримати досвід, якщо не робити операції, найчастіше 

такої можливості у студентів немає. Але проблема вирішується, якщо 

хірурги починають використовувати ВР для тренувань. 

VR дозволяє відновлюватися після операції і травм, наприклад, 

системи використовуються для додаткової стимуляції з травмами 

спинного мозку.   
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1.2 АНАЛIЗ ICНУЮЧИХ ПPOГPАМНИХ ЗАCOБIВ 

Adobe Photoshop - багатoфункцioнальний гpафiчний peдактop, 

poзpoблeний фipмoю Adobe Systems. В ocнoвнoму пpацює з pаcтpoвими 

зoбpажeннями, пpoтe має дeякi вeктopнi iнcтpумeнти. Пpoдукт є лiдepoм 

pинку в oблаcтi кoмepцiйних заcoбiв peдагування pаcтpoвих зoбpажeнь i 

найбiльш вiдoмим пpoдуктoм фipми Adobe. 

Blender - вiдкpитe пpoгpамнe забeзпeчeння для cтвopeння 

тpивимipнoї кoмп'ютepнoї гpафiки, щo включає в ceбe заcoби 

мoдeлювання, анiмацiї, peндepинга, пocтoбpoбки i мoнтажу вiдeo зi 

звукoм, а такoж для cтвopeння iнтepактивних iгop. В даний чаc 

кopиcтуєтьcя найбiльшoю пoпуляpнicтю cepeд бeзкoштoвних 3D-

peдактopiв в зв'язку з йoгo швидким i cтабiльним poзвиткoм, якoму 

cпpияє пpoфeciйна кoманда poзpoбникiв. Хаpактepнoю ocoбливicтю 

пакeту Blender є йoгo нeвeликий poзмip в пopiвняннi з iншими 

пoпуляpними пакeтами для 3D-мoдeлювання. 

Mixcraft - це програма багатоканального запису для Windows. Це 

програмне забезпечення для запису музики функціонує як робоча 

станція цифрового звуку, MIDI секвенсор, віртуальний хост приладу, 

нелінійний аранжувальник відео та програма запису музичних циклів. 

Основні можливості програми 

 MIDI: Ця функція дозволяє записувати MIDI-дані, які 

відтворюються на одній або декількох клавіатурах MIDI-контролера. 

 Multitrack Recording: Ця функція дозволяє користувачам 

створювати записи з декількох звукових / аудіовходів одночасно. 

Unreal Engine 4 - ігровий рушій, розроблений і підтримуваний 

компанією Epic Games. Написаний на мові C ++, рушій дозволяє 

створювати ігри для більшості операційних систем і платформ: Microsoft 
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Windows, Linux, Mac OS і Mac OS X, консолі Xbox, Xbox 360, PlayStation 

2, PlayStation Portable, PlayStation 3, Wii, Dreamcast і Nintendo GameCube. 

Код рушія може використовуватися в будь-яких комерційних 

проектах, але з розробників даних проектів здійснюється відрахування у 

розмірі 5% від доходу, отриманого від продажу гри користувачам. Збір 

відрахувань з доходів від продажу робить рушій Unreal Engine 4 цікавим 

рішенням не тільки для великих ігрових проектів, але і для невеликих 

стартапів і авторів безкоштовних ігор. 

Adobe Fuse CC - (раніше Fuse Character Creator) - це програмне 

забезпечення для комп'ютерної графіки 3D, розроблене компанією 

Mixamo, що дозволяє користувачам створювати 3D-персонажі. Її 

головна новизна - можливість імпортувати та інтегрувати вміст, 

створений користувачем, до створення персонажа. Fuse є частиною 

набору продуктів Mixamo, і призначений для розробників відеоігор, 

модераторів відеоігор та 3D-ентузіастів. 

Fuse - продукт на основі клієнта, що дозволяє користувачам 

вибирати та змінювати компоненти символів, такі як частини тіла, в 

режимі реального часу. Основною новинкою Fuse є можливість 

імпортувати та автоматично інтегрувати свій власний вміст у систему 

створення персонажа, використовуючи всі функції попередньо 

завантаженого контенту. 

 Fuse використовується в основному для розробників ігор і 

модераторів ігор. Fuse доступний на Mixamo, на Unity Asset Store і на 

ринку Steam, де з вересня 2014 року він має 40 000 користувачів. 

Персонажів Fuse можна імпортувати через певну серію кроків у ігри, 

створені за допомогою Source SDK. 
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1.3 POЗPOБКА ЗАГАЛЬНOЇ КOНЦEПЦIЇ ПРОЕКТУ 

 В даній роботі реалізується рухома модель персонажу зі 

змогою взаємодії з навколишнім середовищем. Із навколишнього 

середовища буде створений музей КНТЕУ, відтворена його архітектурна 

форма, внутрішній інтер’єр та оздоблення. 

 

Pиc. 1.1 віртуальні контролери персонажа 

1.4 ВИCНOВКИ ДO ПЕРШОГО POЗДIЛУ 

 В першому розділі була вивчена потрібність віртуальної 

реальності та 3D моделей в ІТ індустрії, проаналізовані існуючі 

програмні засоби для розробки 3D моделей та розроблена загальна 

концепція музею КНТЕУ.  
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РОЗДІЛ 2 ТEХНIЧНE ЗАВДАННЯ НА РОЗРОБКУ ОБ*ЄКТІВ 

VR ЗАСОБАМИ UNREAL ENGINE 4 

2.1. ВИМОГИ ДО ТЕХНІЧНОГО ЗАВДАННЯ 

 Мета - підвищення ефективності освітнього процесу в 

сучасних умовах за рахунок використання нових інформаційних 

технологій (VR), що забезпечують багатофункціональність, 

багатоваріантність, гнучкість і оперативність;  

 Завдання дослідження: аналіз вітчизняних і зарубіжних 

публікацій та інформаційних джерел  по темі науково-дослідної роботи. 

1. Вимоги по розробці об*єктів: 

 Об’єкти повинні відповідати дійсності. 

 Об’єкти повинні надавати достовірну інформацію. 

 Персонаж повинен мати змогу керуватися апаратними 

пристроями та контролерами віртуальної реальності. 

 2. Розміри 

 Музей у своєму фінальному вигляді повинен відповідати 

приблизним розмірам справжньої кімнати. 

 3. Анімація 

 В готовому проекті має бути анімований персонаж, для того 

щоб пересуватись по музею без перешкод. Також повинна бути створена 

анімація відчинення та зачинення дверей. 

 4. Взаємодія 

 В готовому проекті мають бути декілька експонатів музею з 

якими персонаж зможе взаємодіяти, наприклад отримати детальну  
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інформацію про історичну подію або постать. 

2.2 ОПИС ЕТАПІВ РОЗРОБКИ 3D МОДЕЛЕЙ 

2.2.1 Modeling 

Моделювання - це процес візуального зображення об'єктів і 

поверхонь для подальших маніпуляцій. Якщо потрібно створити 

статичний 3D-актив, який не буде виконувати складний набір анімації, 

моделювання стане необхідним способом його створення. Весь процес 

моделювання може бути завершений багатьма способами, залежно від 

того, який з них є найбільш привабливим для 3D-художника. 

 Примітивне моделювання означає створення простих 3D-

об'єктів, таких як сфери, кубики, конуси, змінюючи їх атрибути. 

Використовуючи Modeling Toolkit, виконавець може розділяти, 

витягувати, об'єднувати або видаляти компоненти з об'єктів, щоб 

зробити примітивний об'єкт більш-менш складним. 

 Моделювання кривих - це метод створення 3D-активів, коли 

поверхні маніпулюють кривими, які контролюються зваженими 

контрольними точками. Змінюючи вагу для певної точки, художник 

може наблизити криві до певної точки. Ці криві включають сплайни, 

патчі та NURBS. 

 Конвертація - це метод створення полігонів за допомогою 

моделей поверхні NURBS. 

 Окремі полігони можуть бути зроблені шляхом розміщення 

окремих вершин для демонстрації окремих полігонів. Інструмент 

"Створити багатокутник" або "Quad Draw Tool" може або витягнути, або 

розбити вид полігональної сітки. 
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2.2.2 Retopology 

 Враховуючи, скільки полігонів має висока деталізована модель 

(іноді до 10M), часто стає неможливим створювати належні анімації з 

кількістю точок впливу, з якими має займатися 3D-художник. 

Використовуючи функцію Quad Draw в Toolkit моделювання, у вас є 

доступ до маркування по всій моделі, що дозволяє створювати значно 

спрощену нову топологію на основі поверхні еталонної моделі. 

2.2.3 UV Mapping 

 

Рис. 2.1 UV poзгopтка 

Цей етап означає, що виконавець може зробити 2D-зображення і 

застосувати його до поверхні 3D-моделі для подальшого відображення 

текстур. 



 
Изм. Лист № Документа_ Подпись_ Дата

_ 

Лист 

11 

 

КНТЕУ 121– 06-16.МР 

Розфарбовуючи полігони 3D-моделі кольором та іншими 

параметрами відображення, UV Mapping призначає пікселі зображення 

поверхневим відображенням багатокутника шляхом копіювання та 

вставки фрагмента зображення на об'єкт. 

2.2.4 Rigging 

 

Рис. 2.2 Всі рухомі частини персонажу 

Rigging - це процедура створення "скелета" і прив'язка його до 3D-

сітки. Як скелет в реальному житті, він складається з ряду швів, які 

можуть маніпулювати моделлю, щоб згинатися або нахилятися в 

певному напрямку. 

2.3 ВИСНОВКИ ДО ДРУГОГО РОЗДІЛУ 

 У другому розділі були описані основні етапи розробки музею, 

такі як моделювання, конвертація, ретопологія та створення UV 

розгортки. Також було встановлено завдання та вимоги для створення 

музею.
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РОЗДІЛ 3. РЕАЛІЗАЦІЯ ОБ`ЄКТІВ VR ЗАСОБАМИ UNREAL ENGINE4 

3.1 ВИКОРИСТАНЕ ПЗ 

 Для реалізації алгоритму було обрано такий набір програмного 

забезпечення: 

Назва Плюси Мінуси 

Mixcraft 8 

 Зрозумілий інтерфейс; 

 Можливість запису 

одразу з декількох 

аудіовходів; 

 Можливість роботи з 

усіма аудіо форматами; 

 Висока надійність 

 Унікальні інструменти. 

 За час використання 

суттєвих недоліків не 

було виявлено. 

Unreal Engine 4 

 Безкоштовний; 

 Можливість візуального 

програмування; 

 Потужний редактор 

матеріалів та штучний 

інтелект; 

 Фото-реалістична 

візуалізація. 

 Високі системні 

вимоги. 

Таблиця 3.1. 

Кінець таблиці 3.1. 
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3.2 ЕТАПИ СТВОРЕННЯ ОБ*ЄКТІВ VR ЗАСОБАМИ UNREAL 

ENGINE4 

 Створення кімнати; 

 Створення базових елементів інтер'єру; 

 Моделювання експонатів; 

 Взаємодія з тривимірними об'єктами. 

Перше, що необхідно зробити при створенні 3Д музею – це створити 

кімнату в якій в подальшому будуть розміщуватись експонати. Для цього 

необхідно провести розрахунки розмірів експонатів та самої кімнати. 

Для початку необхідно створити підлогу. Для цього необхідно відкрити 

вкладку «Geometry»,  в якій треба вибрати фігуру «Box». 

 

Рис. 3.1. створення проекту віртуальної реальності 

Далі необхідно розширити простір. За допомогою вкладки «Geometry 

Editing» розширюємо куб по осям. 
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Рис. 3.2. Створення підлоги 

Наступний етап у створенні кімнати – це стіни. Для створення стіни 

необхідно відкрити вкладку «Geometry»,  в якій треба знову вибрати фігуру 

«Box». 

 

Рис. 3.3. Створення стіни 

Далі необхідно розтягнути куб по осям. 
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Рис. 3.4. Створення стіни 

Копіюємо та розміщуємо стіни так, щоб вийшла коробка. 

 

Рис. 3.5. Необроблена кімната 

Після виконання цих пунктів можна поступово переходити до базових 

елементів інтер'єру. 

Для підлоги було використано дерев'яну текстуру. 
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Рис. 3.6. Матеріал підлоги 

Так виглядає підлога  після покриття дерев'яним матеріалом. 

 

Рис. 3.7. Матеріал підлоги 

Далі стіни покриваємо таким самим способом, але іншим матеріалом. 
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Рис. 3.8. Матеріал стіни 

Після облаштування стін та стелі кімната має наступний вигляд. 

 

Рис. 3.9. Вигляд кімнати 

Для кращого освітлення необхідне потрапляння зовнішніх джерел 

світла.  

Для створення вікон необхідно в одній зі стін проробити отвори. Для 

цього відкриваємо вкладку «Geometry»,  де вибираємо фігуру «Box». Далі в 
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параметрах пензля (Brush Settings) вибираємо параметр «subtractive», після 

чого куб стає невидимим і його необхідно пересунути так, щоб він 

перетинався з іншим геометричним об'єктом. 

 

Рис. 3.10. Створення вікна 

Наступним кроком просто копіюємо вікна та розміщуємо іх як це 

потрібно. 

 

Рис. 3.11. Послідовне розміщення вікон 

Отвори готові, але залишати вікна без рами та скла не можна. Для рами 

використаємо 3D-модель металопластикового вікна. 
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Рис. 3.12. Модель вікна 

Рис. 3.13. Моделі вікон 

Після створення кімнати з базовим інтер'єром можна перейти до її 

заповнення елементами декору. В музеї КНТЕУ є декілька видів стендів і 

вітрин. Розглянемо п'ятикутну та прямокутну вітрини які займають своє 

місце біля вікна. 
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Рис. 3.14. П'ятикутна та прямокутна вітрини 

В арсеналі платформи Unreal Engine 4 немає складних геометричних 

фігур, таких як додекаедр, пентагондодекаедр або будь-який об'ємний 

п'ятикутник, тому довелося створити його використовуючи куб. 

Створимо паралелепіпед який буде складатися с куба та паралелепіпеда 

менших розмірів. 

 

Рис. 3.15. Прямокутний кубоїд 

В 2D редакторі за допомогою мишки перетворюємо прямокутник в 

правильний п'ятикутник – пентагон. 
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Рис. 3.16. Пентагон 

Отримавши п'ятикутник покриваємо його дерев'яним матеріалом. 

 

Рис. 3.17.  Дерев'яний пентагон 

Для того, щоб зробити з даної фігури вітрину, необхідно проробити в 

ній п'ятикутний отвір. Для цього необхідно копіювати пентагон та за 

допомогою панелі з редактором розміру зменшити фігуру відповідно до 

пропорцій які потребуються.  

 

Рис. 3.18. Заготовка вітрини 
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Щоб закінчити п'ятикутну вітрину – необхідно вкрити її склом та 

поставити на підставку. Для створення скляної панелі копіюємо 

пентагон та за допомогою панелі редактора розмірів робим його 

максимально пласким. 

 

Рис. 3.19. Модель готової вітрини 

Дотримуючись даного методу було створено решту елементів 

віртуального музею. 

Наступною дією буде створення рухомого актора та його взаємодія з 

елементами музею. Базові рухи актора, такі як: рухи вперед, назад, в 

боки та стрибки генеруються програмою автоматично. Складні анімації 

рухів та взаємодія з навколишнім середовищем програмується 

власноруч. 
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Рис.3.20. Blueprint системи руху актора 

Одним з елементів взаємодії між актором та середовищем були 

двері, що автоматично відкриваються при наближенні актора на певну 

відстань, анімація для яких створювалась власноруч. 

 

Рис. 3.21. Інтерфейс вікна для створення анімації 
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Рис. 3.22. Blueprint для анімації дверей 

Принцип дії цієї анімації полягає в тому, що на ігровому рівні 

розміщується певна область (Trigger Box), перетнувши яку гравець 

надсилає системі сигнал про те, що вданий момент часу необхідно 

увімкнути анімацію, а коли актор перестає знаходитись в зоні, тоді 

починає діяти такий Blueprint як OnActorEndOverlap, який дає системі 

знак що необхідно запустити ту ж саму анімацію, але задом наперед. 

Наступним прикладом взаємодії є приклад взаємодії актора та 

експонатів, в даному випадку – картиною. Принцип роботи даного 

скрипта полягає в тому, що створюється окрема область при перетині 

якої на екрані з'являється віджет з вказівкою натиснути на вказану 

клавішу, щоб прослухати інформацію про вказаний експонат. Коли ця 

клавіша натискається у спеціальній створеній області – то все 

відбувається за сценарієм і звук відтворюється без помилок, але як 

тільки актор покине цю зону віджет одразу ж зникає і звук не буде 

відтворюватися. 
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Рис. 3.23. Приклад роботи взаємодії з одним експонатом 

 

Рис. 3.24. Загальна кількість зв'язків в усій програмі 
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3.3 ЕКСПОРТ ГОТОВОГО ПРОЕКТУ 

Перш ніж експортувати свій проект, вам спочатку потрібно 

встановити мапу за замовчуванням гри, яка буде завантажуватися, коли 

починається ваша гра. Якщо ви не встановили карту і використовуєте 

порожній проект, ви побачите лише чорний екран, коли починається гра. 

Щоб встановити мапу за замовчуванням гри, натисніть головне меню 

Edit> Project Settings> Maps & Modes: 

 

Рис 3.25 Вікно «Карти та Режими» 

 Щоб упакувати проект для певної платформи, у головному меню 

редактора натисніть File> Package Project> [PlatformName]: 
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Рис 3.26 Вибір платформи 

Після підтвердження цільового каталогу буде ініційовано поточний 

процес, який упаковує проект для вибраної платформи. Оскільки 

пакування може займати багато часу, цей процес виконується у фоновому 

режимі, і ви можете продовжувати використовувати редактор. Індикатор 

стану відображатиметься в нижньому правому куті редактора, щоб 

вказати прогрес: 

 

Рис 3.27 Індикатор стану 

Індикатор стану також надає кнопку Скасувати, щоб зупинити процес 

упаковки. Крім того, посилання "Показати журнал" може 

використовуватися для відображення інформації про розширений 

вихідний журнал, що є корисним для з'ясування того, що пішло не так, 

якби процес упаковки вийшов з ладу, або для виявлення попереджень, які 

могли б виявити потенційні помилки в продукті: 
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Рис 3.28 Розширений вихідний журнал 

3.4 ВИСНОВКИ ДО ТРЕТЬОГО РОЗДІЛУ 

В третьому розділі був описаний повний цикл створення об’єктів 

віртуальної реальності 3D-музею КНТЕУ, покроково описаний процес 

експорту проекту та зроблено порівняння плюсів та мінусів обраних 

програмних засобів. Був реалізований спосіб контролю персонажа 

використовуючи контролери HTC Vive. 
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ВИСНОВКИ ТА ПРОПОЗИЦІЇ 

У цьому дипломному проекті була проведена робота з розробки 

алгоритму та створення музею у віртуальній реальності. 

В першому розділі була описана потрібність віртуальної реальності в 

сучасній сфері ІТ, проаналізовані програмні засоби та побудована 

загальна концепція. 

У другому розділі були описані основні етапи розробки музею, такі як 

моделювання, конвертація, ретопологія та створення UV розгортки. 

Також було встановлено завдання та вимоги для створення об’єктів 

віртуальної реальності. 

У третьому розділі був описаний повний цикл створення 

інтерактивного VR-музею КНТЕУ, покроково описаний процес експорту 

проекту та зроблено порівняння плюсів та мінусів обраних програмних 

засобів.    

В рамках проведеного ВКП опрацьовані методи створення VR-образів 

музейних експонатів з використанням: 

● фотограмметрії 

● 3D-сканування 

● шляхом розробки та реалізації алгоритму створення тривимірної 

моделі з використанням сучасних графічних програм. 

Результати даної роботи можуть бути впроваджені при 

розробці WEB-сайту віртуального музею КНТЕУ. 

Результати цієї роботи пройшли апробацію на Міжнародних науково- 

практичних конференціях. Робота має номер державної реєстрації 

0117U000057. 
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ТЕХНІЧНЕ ЗАВДАННЯ 

  

Однією з найголовніших запорук відповідності вимогам та 

високої якості розробленого програмного рішення є грамотно 

спроектоване до початку розробки технічне завдання. Отже, 

необхідно розкрити невід’ємні положення технічного завдання до 

розробки об’єктів Virtual Reality (VR) засобами Unreal Engine4. 

1. Загальна інформація 

Назва проекту: KNUTE museum.  

Планові строки розробки: грудень 2020 – вересень 2020. 

Призначення програмного рішення: віртуалізація музейного 

простору КНТЕУ. 

Мета створення програмного рішення: опанування сучасних 

технологій розробки VR-додатків та їх закріплення на практиці. 

2. Функціональні вимоги до додатку 

До функціональних можливостей повинні входити – керування 

персонажем через клавіатуру та контролери віртуальної реальності, 

взаємодія з віртуальним середовищем. 
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ПРОГРАМА ТА МЕТОДИКА ТЕСТУВАННЯ 

Unreal Engine містить вбудований набір інструментів для 

тестування і налагодження вашого проекту. Ви можете запустити 

програму прямо у вікні редактора, в реальному часі спостерігаючи за 

тим, як змінюються об'єкти, які виникають події і як протікає 

виконання заданих сценаріїв. 

LogD3D11RHI:      Driver Date: 7-3-2019 

LogRHI: Texture pool is 1379 MB (70% of 1970 MB) 

LogD3D11RHI: Async texture creation enabled 

LogD3D11RHI: GPU Timing Frequency: 1000.000000 (Debug: 2 2) 

LogTemp: Display: Module 'AllDesktopTargetPlatform' loaded TargetPlatform 

'AllDesktop' 

LogTemp: Display: Module 'MacClientTargetPlatform' loaded TargetPlatform 

'MacClient' 

LogTemp: Display: Module 'MacNoEditorTargetPlatform' loaded TargetPlatform 

'MacNoEditor' 

LogTemp: Display: Module 'MacServerTargetPlatform' loaded TargetPlatform 

'MacServer' 

LogTemp: Display: Module 'MacTargetPlatform' loaded TargetPlatform 'Mac' 

LogTemp: Display: Module 'WindowsClientTargetPlatform' loaded TargetPlatform 

'WindowsClient' 

LogTemp: Display: Module 'WindowsServerTargetPlatform' loaded TargetPlatform 

'WindowsServer' 

LogTemp: Display: Module 'WindowsTargetPlatform' loaded TargetPlatform 

'Windows' 

 

 

 



 

ДОДАТКИ 

Додаток А 

 

Лістинг програмного коду для додавання скелетної сітки до 

контролерів руху 

 
USkeletalMeshComponent* AcVRPlayerPawn::CreateHandMesh(UMotionControllerComponent* 

a_compParent, FName a_strDisplayName, FName a_nameHandType) 
{ 
USkeletalMeshComponent* refComponentHand = NULL; 
  
//Find the default cube that ships with the engine content 
static 
ConstructorHelpers::FObjectFinderHandMeshObject(TEXT("SkeletalMesh'/Game/VirtualReality/Mannequi

n/Character/Mesh/MannequinHand_Right.MannequinHand_Right'")); 
if (!HandMeshObject.Object) 
{ 
UE_LOG(LogTemp, Error, TEXT("Could not load the default cube for hand mesh")); 
return NULL; 
} 
  
//create the mesh component 
refComponentHand = CreateDefaultSubobject(a_strDisplayName); 
//set the mesh to the component 
refComponentHand->SetSkeletalMesh(HandMeshObject.Object,true); 
  
//Set the defaults 
refComponentHand->SetAutoActivate(true); 
refComponentHand->SetVisibility(true); 
refComponentHand->SetHiddenInGame(false); 
FQuat qRotation = FQuat::Identity; 
FVector vec3Scale = FVector::OneVector; 
if (a_nameHandType == FXRMotionControllerBase::LeftHandSourceId) 
{ 
qRotation = FQuat(FVector(1, 0, 0), FMath::DegreesToRadians(90)); 
vec3Scale = FVector(1, -1, 1); 
//a_refHand->SetVisibility(false); 
//a_refHand->SetHiddenInGame(true); 
} 
else 
{ 
qRotation = FQuat(FVector(1, 0, 0), FMath::DegreesToRadians(270)); 
} 
refComponentHand->SetRelativeLocationAndRotation(FVector::ZeroVector, qRotation); 
refComponentHand->SetRelativeScale3D(vec3Scale); 
refComponentHand->SetupAttachment(a_compParent); 
  
return refComponentHand; 
} 
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